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SCHEME OF EXAMINATION

BACHELOR OF SCIENCE (ANIMATION & MULTIMEDIA)

THREE YEAR PROGRAMME (SEMESTER SYSTEM)

2011

First Year
Note:

1. There will be 70 multiple choice questions (MCQ’s) in the question paper consisting of one mark each. Students are
required to attempt all the questions.
Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination
to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks the theory marks secured by the candidate shall be proportionately enhanced.

First Semester

Paper Nomenclature Nature 
of Exam. 

Theory Practical Total 
Marks 

   External Internal   
DEBAM-101 Introduction to Computer & 

Internet Theory 70 30  100 

DEBAM-102 Introduction to Multimedia and 
Its Application   

Theory  70 30  100 

DEBAM-103 Drawing and Sketching Theory+ 
Practical 

50  50 100 

DEBAM-104 Typography Theory + 
Practical 

50  50 100 

Second Semester

Paper Nomenclature Nature of 
Exam. 

Theory Practical Total 
Marks 

DEBAM-201 Computer Graphics Part I: 
Photoshop 

Theory + 
Practical 

50 50 100 

DEBAM-202 Computer Graphics Part I: 
Adobe Illustrator 

Theory + 
Practical 

50 50 100 

DEBAM-203 Print Media Part I: CorelDraw Theory + 
Practical 

50 50 100 

DEBAM-204 Print Media Part II: Quark 
Express 

Theory + 
Practical 

50 50 100 

DEBAM-205 Environment Studies 
(qualifying subject)* 

 70 30 100 

Important Note:
* The Environmental studies is a qualifying paper for all UG Courses. Students are required to qualify the same, otherwise final result will not be

declared and degree will not be awarded. Paper setting, conduct of examination and its evaluation will be done at the study centre itself.
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Second Year

Third Semester

Paper Nomenclature Nature of 
Exam. 

Theory Practical Total 
Marks 

DEBAM-301 Introduction to Web 
Development 

Theory + 
Practical 

50 50 100 

DEBAM-302 HTML Theory + 
Practical 

50 50 100 

DEBAM-303 Computer Animation: 
Introduction to Flash  

Theory + 
Practical 

50 50 100 

DEBAM-304 Content Authoring on Web 
Using Macro Media 
Dreamweaver 

Theory + 
Practical 

50 50 100 

Fourth Semester

Paper Nomenclature Nature of 
Exam. 

Theory Practical Total 
Marks 

DEBAM-401 Developing Dynamics Web 
Pages using Java and VB 
Scripts 

Theory + 
Practical 

50 50 100 

DEBAM-402 Introduction to 3Ds MAX Theory + 
Practical 

50 50 100 

DEBAM-403 Workshop on Communication 
Skills 

Workshop  100 100 

DEBAM-404 Developing Presentation Theory + 
Practical 

50 50 100 

Third Year
Fifth Semester

Paper Nomenclature Nature of 
Exam. 

Theory Practical Total 
Marks 

DEBAM-501 Introduction to Maya Theory + 
Practical 

50 50 100 

DEBAM-502 Audio Editing: Sound Forge Theory + 
Practical 

50 50 100 

DEBAM-503 Video Editing: Adobe Premier Theory + 
Practical 

50 50 100 

DEBAM-504 Modeling  Shoowreel Practical  100 100 

Sixth Semester
Paper Nomenclature Nature of 

Exam. 
Theory Practical Total 

Marks 

DEBAM-601 Character Set-up and 
Animation in Maya 

Theory + 
Practical 

50 50 100 

DEBAM-602 Advance 3D Max  Practical  100 100 
DEBAM-603 CG- Film Making Theory + 

Practical 
50 50 100 

DEBAM-604 Animation Demo Reel Practical  100 100 
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BACHELOR OF SCIENCE (ANIMATION OF MULTIMEDIA)

First Semester
INTRODUCTION TO COMPUTER & INTERNET

PAPER CODE: DEBAM-101
External: 70
Internal: 30

Note:
1. There will be 70 multiple choice questions (MCQ’s) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks the theory marks secured by the candidate shall be proportionately enhanced.

Unit 1
Introduction to Computers: What is a Computer? Some Beginning Terms, What Makes a Computer Powerful, Speed,
Reliability,  Storage, Diligence, Versatility, Power of Remembering, No  IQ, No Feeling, History of Computer, Calculating
Machines, Napier’s Bones, Slide Rule, Pascal’s Adding and Subtractory Machine; Leibniz’s Multiplication and Dividing Machine,
Babbage’s Analytical Engine, Mechanical and Electrical Calculator, Modern Electronic Calculator, Computer Generations,
First Generation Computers, Second Generation Computers, Third Generation Computers, Fourth Generation Computers,
Fifth Generation Computer, Types of Computers, Personal or Micro, Descriptions of Personal Computers, Main Frame,
Supercomputers Server, Minicomputer.

Unit 2
Computer Organisation: Introduction, Basic Computer Operations, Input, Storage, Processing, Output, Control, Functional
Units, Arithmetic Logical Unit (Alu), Control Unit (Cu), Central Processing Unit (CPU), Memory System in a Computer,
Capacity of Primary Memory, Random Access Memory (Ram), Read Only Memory (Rom), Prom, Eprom, Cache Memory,
Registers, Secondary Storage, Magnetic Tape, Magnetic Disk, Optical Disk.

Unit 3
Software Application: Word processing, Create, Format, Print, Desktop publishing, Levels of Software, Spreadsheet, Database,
Types of databases, Relational Database, Queries, Graphics Programs, Paint, Drawing Programs, Animation and Video Programs,
Presentation, Programs, Communication Programs, FTP (File-Transfer Protocol). Chat, Instant, Messaging, HTML Editor,
Project Management Program Integrated Software.

Unit 4
Input to Computers: Types of Input, Keyboard, Mouse, Trackball, Glide-pad, Game Devices, Pen, Touch-screen, Digitizers
and Graphic Table, Point-of-sale Terminal (POS), Multimedia, Sound Input, Voice Input, Video Input, Data Automation,
General Devices, OCR Software, Checking for Accuracy.

Unit 5
Data Processing: Processing is the Thinking, Processing, Digital Data, Digital Codes, Unicode, Parity, Machine Cycle,
Speed, Memory Addresses, Update, Processor Speed, Physical Components, Microprocessor, ROM (Read Only Memory),
Memory Devices,  Memory  Speed, Motherboard,  ISA  Slots,  PCI  Slots, Connectors, Memory Slots, Keyboard Plug, Power
Connections, Processor Socket.
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Unit 6
Output Devices: Types of Output, Categories of Output, Printer Features, how last?, what Print quality?, what Printer will
Print?, Cable Connection, Serial Cable, Parallel Cable,USB Cable, Types of Printers, Impact Printers, Types of Impact Printers,
Non-Impact Printers, Types of Non-Impact Printers, Screen, LCD screen, Screen Features, Type of Screens.

Unit 7
Data Storage: Data Storage, Magnetic Disk, Types of Magnetic Disks, Disk Format, Tracks, Sectors, Clusters, Cylinders,
Disk Capacity, Accessing Data, Magnetic Tape, Types of Tape, Tape Formats, Optical Disks, Advantages of Optical Disks,
Disadvantages of Optical Disks, Care of Optical Disks (CDs, DVDs), Recording.

Unit 8
Internet Basks: What is the Internet?, Interoperable, Packet Switched, Data, Network, TCP/IP, e-mail, FTP, www, Gopher,
Internet History, IP Address, Domain Name, Gateway, Repeater, Bridge, Router, Packet, Firewall Ethernet, WWW, Search
Engine, URL, Home Page, Portal.

Unit 9
Internet Study: Introduction, Web Directories, Comprehensive Directories, Yahoo, Argus Clearinghouse Infoseek/Go Guide,
Topical Directories, Search Engines, Crawlers, and  Spiders, Alta Vista, Excite, HotBot, Lycos,  Web Crawler,  Meta-search
Engines, Profusion. Search, Go2Net/MetaCrawie’r SavvySearch, Portals, My Yahoo!, Sbap.com, Search Strategies, AND,
OR , NOT, Using the Wild Card, Beyond the, Basics: Thinking Critically About Web Sites, Decoding Web Site Addresses,
Evaluation of Information-Sources, How to Be Net Savvy.

Unit 10
Microsoft Word Xp 2003 Or 2002: Microsoft Word 2003/2002 for Windows, The Title Bar, The Menu Bar, The Ruler,
Document View, Word 2002, Text Area, Exiting Word, Things You Need to Know, Click, Options, Word 2002. Nonprinting
Characters, Recently Used File List, Setting Options, Highlighting Text, Highlighting Menu Items, Placing the Cursor Microsoft
Word Basic Features, Typing and Using the Backspace Key, Inserting Text, Overtype, Bold, Underline, and Italicize, Save File,
More Basic Features, Open File, Cut and Paste, AutoText, Spell Check, Find and Replace, Font Size, Fonts, Save File,
Working with Paragraphs, Sample Paragraphs, Space Before and Space, After, Line Spacing, Alignment, Hanging Indent Tab
Key, Buikting, Numbering, Undo, Redo, and Printing, The Tab Key, Bullets and Numbering, Undo, & Redo, Selecting Accounting
Software, Tables, Creating a Table, Moving; Around a Table, Selecting a Row and Bolding the Text, Right Aligning Text,
Adding a New Row to the End of the Table, Adding a Row Within the Table, Resizing the Columns, Adding a New Column to
a Table, Sorting a Table, The Sum Function, Deleting a Column, Merge Cell, Table Headings Converting Text to a Table,
Splitting a Table, Table AutoFormat.

INTRODUCTION TO MULTIMEDIA AND ITS APPLICATION

PAPER CODE: DEBAM-102

External: 70
Internal: 30

Note:
1. There will be 70 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.
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Unit-1
Introduction to Multimedia Systems: History of Multimedia Systems, What is Multimedia? Challenges for Multimedia Systems,
Desirable Features for a Multimedia System, Components of a Multimedia System, Applications, Trends in Multimedia.

Unit-2
Multimedia Systems and Applications: Categorization of Multimedia, Major Characteristics of Multimedia, Terminology, Usage,
Structuring Information in a Multimedia Form.

Unit-3
Computer Graphics: Computer Graphics, Bitmap Images, Vector Graphics, Graphics Software, Graphics File Format.

Unit-4
Computer Animation: Introduction, Early Animation Techniques, Innovations of Animators at Disney, Types of Animation,
Software for Animation, Difference Between Traditional Animation and Computer Animation, Pixar and Disney Studio.

Unit-5
Interactive Media: Introduction, Terminology, World Wide Web, Internet Forums, Computer Games, Mobile Telephony,
Interactive Television, Hypermedia.

Unit-6
Multimedia Hardware: Multimedia Computers, Input Devices, Output Devices, End User Hardware Issues, Storage, Buses.

Unit-7
Multimedia in Education: Introduction, Terminology, Education Online, The Problem is the Solution, A Vision for the Future,
Conclusion.

Unit-8
Multimedia and Virtual Reality: Introduction to Multimedia and Virtual Reality, Technological Issues, Computer Science Aspects,
User Interface, Interaction with Geographic Information, Applications, Potential.

Unit-9
Multimedia: Application and Future: Multimedia, Applications For Multimedia, Multimedia in the Future.

DRAWING AND SKETCHING

PAPER CODE: DEBAM-103

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.
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Unit 1: Introduction to Drawing
How to Draw, How to Choose a Pencil, How to Improve Your, Drawing Skills, How to Ink a Drawing, How to Sketch.

Unit 2: Drawing Shapes and Forms
Draw a Box, Draw a Circle, Draw a cylinder, Draw a Hexagon, Draw a Perfect Pentagram, Draw a Octagonal Based
Pyramid, Draw a Cartoon Car, Draw a Simple House

Unit 3: Drawing Text and Lettering
How to Draw 3D Block Letters, How to Draw Bubble Letters, How to Make an Ambigram, How to Have Beautiful Writing ,
How to Improve Your Calligraphy Writing, How to Design a Logo

Unit 4: Drawing Realistic and Cartoon Characters
How to Draw Basic Human Figures, Hoe to Draw a Body , How to Draw People, How to Draw Realistic People, How to
Draw Human Faces, How to Draw a Cartoon Man, How to Draw a Funny Looking Face, How to Draw a Simpsons
Character

Unit 5: Drawing Animals
How to Draw Realistic Animals with Depth, How to Draw an Elephant, Draw a Horse, How to Draw a Bird, Hoe to Draw a
Cat, How to Draw a Dog, How to Draw a Pig, How to Draw a Dog Face, How to Draw a Frog

Unit 6: Cartoon and Comic Drawing
How to Draw a Cartoon like Face, How to Draw Bobble Men , How to Draw a Cartoon Cat, How to Draw a Cute Cartoon
Person, How to Draw a Cartoon Monkey, How to Draw a Stick Figure, How to Draw Monsters, How to Draw a Sea Creature

Unit 7: Perspective Drawing
One Point Perspective, Two Point Perspective

TYPOGRAPHY

PAPER CODE: DEBAM-104

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.

Type Technology: History and Emergence
Type Technology-The Four Revolutions, Type Forms Through the Centuries, Decorative & Display Type, Synthesis.
Typography
Introduction to Typography, Design, Basic Type Anatomy, Major Typeface Classifications, Letter spacing, Type Measurement,
Font-Type Definitions, Typographic Terms, When Choosing Typefaces do.
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Typographic Design Consideration
Measure the Measure, Hanging Punctuation, Ligatures, Typographic Hierarchy – Size, Typographic Hierarchy - Weight.
In-Design Tutorial for Typographic Designs
Tutorial #1: Simple Type Exercise, Tutorial #2: Simple Formatting, Tutorial #3: Simple Table, Tutorial #4: Complex Formatting,
Tutorial #5: Graphic Creation.
Copy Preparation, Design and Layout
Copy Preparation, The Printers’ Point System, Principles of Design, Margins, Layouts for DTP & Printing, Type Faces,
Classification of Types, Type Setting, Proof Reading.
File and Font Formats
File Formats, File Format Extensions, Font Formats, Font Format Extensions.

Second Semester

COMPUTER GRAPHICS PART I: PHOTOSHOP

PAPER CODE: DEBAM-201

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.

Introduction: What is Photoshop?, The RGB Color Space, Digital Image Types: Vectors and Bitmaps, Internet Image
Standards.
Photoshop Workplace: The Workplace, The Photoshop Workspace, Preferences, ImageReady.
Creating Images: Creating New Images, Contents, Image Window, Scanning Images into Photoshop, Importing Existing
Images into Photoshop, Magnification/Navigation Controls, The History Palette, The Snapshot.
Creating and Using Selections: Selections and Channels, Multiple Selections, Modifying Selections, The Info Palette,
Moving Selections, Selection Tool Options, Creating Selections in Quick Mask Mode.
Photoshop’s Layer: Layers, Using Layers, Creating New Layers, Text and Layers, Layer Styles, Managing Layers.
Editing Images: Using the Painting and Drawing Tools, Pattern Stamp Tool, Gradient Tool, Using the Type Tool, The
Character Palette, The Paragraph Palette, Fine-Tuning Filters with Fade, Curves, Adjustment and Fill Layers.
Editing Vector Shapes: Working with Vector Content, Creating a Selection from a Path, The Shape Tools, Combination
Options, Generic Shape Tool Options, Layer Style.
Creating Static Image: Creating a Logo in Photoshop, Preparing the Logo for the Internet, Save for Web, Creating a
Custom Logo.
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COMPUTER GRAPHICS PART II: ADOBE ILLUSTRATOR

PAPER CODE: DEBAM-202

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.

Unit 1
Understanding Illustrator: Understand Illustrator’s Role in the World of Digital Graphics, Get Your Hands Around Illustrator’s
Curves, Understand Paths, Anchor Points, and Fills, Use Illustrator with Other Programs, Get Around in Illustrator, Open a
File, Use the Window Menu to Organize Views, Work with Palettes, Use Illustrator’s Toolbox, Tools in Illustrator, Default
Displayed Tools, Tearoffs, Pan Tools, Line Segment Tools, Rotate Tools, Warp Tools, Sprayer Tools, Eyedropper Tools,
Hand Tools, Direct Selection Tools, Type Tools, Shape Tools, Scale Tools, Pencil Tools,’ Graph Tools, Blend Tools, Scissors
Tools, Fills and Views

Unit 2
Creating Documents: Set Up a New Document, Customize Preferences, Set Default File & Clipboard Settings, Navigate Your
Page

Unit 3
Draw with the Pencil and Brush Tools: Draw with the Pencil Tool, Edit Anchor Points with the Direct Selection Tool, Define
Caps and Joins, Assign Stroke or Fill Colors with the Eyedropper or Paint Bucket Tool

Unit 4
Draw with the Pen Tool: Pen Tool, Create and Edit Smooth Anchor Points, Draw Wave Forms, Manipulate Control Points,
Edit with the Pen Tool, Manage Paths.

Unit 5
Work with Shapes: Shapes, Draw Ellipses and Circles, Draw Polygons and Stars, Flare Tool, Pathfinder Tools, Use Shape
Modes

Unit 6
Scale, Skew, and Rotate: Scale, Skew, and Rotate, View a Bounding Box, Resize and Reshape with a Bounding Box, Rotate
and Flip with a Bounding Box, Use More Transform Tools

Unit 7
Text Formatting: Format Characters, Define Stroke and Fill for Type, Format Paragraphs, Align Paragraphs, Display Hidden
Characters, Set Tabs, Define Type Styles, Convert Text to Outlines
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Unit 8
Import Artwork: Import Art, Choose Between Importing and Linking, Trace Imported Bitmaps, Organize Bitmaps with the
Links Palette

Unit 9
Filters and Effects: Applying Effects, Two Types of Effects, Path-Bending Effects, Convert To Shape Effects, Path Effects,
Pathfinder Effects, Rasterize Effects, SVG Filter Effects, Warp Effects, Exploring Fill Effects, Applying Filters, Applying a
Gradient Mesh

PRINT MEDIA PART I: COREL DRAW

PAPER CODE: DEBAM-203

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination

to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.

Object Overview: Object Overview, Pick Tool Overview, Shape Tool Overview, Zoom Tool Overview, Freehand Tool
Overview, Rectangle Tool Overview, Ellipse Tool Overview, Spiral Tool Overview, Polygon Tool Overview, Graph Paper Tool
Overview.
Tools: Selecting Objects, Align Objects, Distribute Object Sets, Group and Ungroup Objects, Modify Multiple Objects, Copy
Object Properties, Using Guidelines, Undo/Redo/Revert Commands, Changing Object Order, Cut or Copy an Object.
Pattern Fill: Pattern Fill Overview, Using Preset Full color Fills, Loading Full Color Fills, Using Bitmap Pattern Fills, Load
External Bitmap Fills, Using Pattern Fill Options.
Fill Tool: Fill Tool Overview, Creating Solid Fills, Fountain Fill Overview, Creating Linear Fountain Fills, Creating Radial
Fountain Fills, Creating Conical Fountain Fills, Creating Square Fountain Fills, Creating Custom Fountain Fills.
Text Tool: Text Tool Overview, Create Artistic Text, Create Paragraph Text, Change Font, Set Default Font and Size, Align
Artistic Text, Align Paragraph Text.
Vectors and Bitmaps: Vectors and Bitmaps, Set View, Work in Wire frame View, Hints for Learning CorelDraw, Menu
Overview: Part 1, Menu Overview: Part 2, Dockers Overview.
Import/Export Overview: Import/Export Overview, Import a File, Edit Vector Import, Edit Bitmap Import, Export a File,
Export GIF File, Export JPG File, Export AI File, Export CDR File.

PRINT MEDIA PART II: QUARK EXPRESS

PAPER CODE: DEBAM-204

External: 50
Practical: 50

Note:
1. There will be 50 multiple choice questions (MCQ's) in the question paper consisting of one mark each. Students are

required to attempt all the questions.
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2. Internal assessment marks shall be given on the basis of marks secured by the candidate in the Descriptive Examination
to be conducted by the respective study centre. Study centres are required to keep the record of the descriptive
examination with them for inspection by the University. The marks of Internal Assessment must be submitted to the
University before the termination of the University Examination in the concerned subjects. In the event of non receipt
of the Internal Assessment Marks, the theory marks secured by the candidate shall be proportionately enhanced.

Unit-1
Introduction: Introduction, Basic Objects - Boxes and Lines, Object Shape, Outline and Colour Properties, Tools and References

Unit-2
Setting Up Quarkxpress References: Part One: Setting up Application Preferences; Edit > References > Application.

Unit-3
Setting Up Quarkxpress References: Part Two: Edit > Preferences > Document, “General” tab, Paragraph tab, Character tab,
Total tab and Trapping tab, Creating Setting Up QuarkXPress™ Tool Defaults - Part One, Creating Setting Up QuarkXPress™
Tool Defaults - Part Two, Setting up the Colour Palette.

Unit-4
Images with Embedded Clipping Paths in Quarkxpress: Clipping Paths.

Unit-5
Working with Master Pages in Quarkxpress: Master Pages, Changing Master Page Objects to Document Page Objects, How
to Change the Margins.

Unit-6
Recovering from and Preventing Data Loss In Quark: Enable Auto Backups, Save Often, Make Laser Printouts, Data Recovery
- Step by Step, Corrupted Image, Corrupted QuarkXpress Document File, Test Your Backups.

Unit-7
Appending H & JS in Quarkxpress: Hyphenation and Justification, Tips for Fast Working.

Unit-8
Creating Stroked Text in Quarkxpress: Introduction, Using Abode Illustrator to Create the Effect, Using Quarkxpress to
Create and Effect.

Unit-9
Working with EPS Files in Quarkxpress and Photoshop© - Part One: Introduction, Working with EPS Files.

ENVIRONMENT STUDIES (QUALIFYING SUBJECT)*

PAPER CODE: DEBAM-205

Internal: 100


